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Repeated injury to airway tissue can impair lung function and cause chronic lung
disease, such as chronic obstructive pulmonary disease. Advances in regenerative
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medicine and bioreactor technologies offer opportunities to produce lab-grown
functional tissue and organ constructs that can be used to screen drugs, model
disease, and engineer tissue replacements. Here, a miniaturized bioreactor coupled
with an imaging modality that allows in situ visualization of the inner lumen of
explanted rat trachea during in vitro tissue manipulation and culture is described.
Using this bioreactor, the protocol demonstrates imaging-guided selective removal
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of endogenous cellular components while preserving the intrinsic biochemical
features and ultrastructure of the airway tissue matrix. Furthermore, the delivery,
uniform distribution, and subsequent prolonged culture of exogenous cells on the
decellularized airway lumen with optical monitoring in situ are shown. The results
highlight that the imaging-guided bioreactor can potentially be used to facilitate the
generation of functional in vitro airway tissues.
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Introduction
The luminal surface of the respiratory tract is lined by a

airway epithelium is associated with devastating respiratory

layer of epithelium that mainly consists of multi-ciliated, club,

diseases, such as chronic obstructive pulmonary disease

goblet, and basal stem cells1 , 2 . The epithelial layer serves

(COPD)5 , primary ciliary dyskinesia (PCD)6 , and cystic

as a primary defense mechanism of the lung, acting as a

fibrosis (CF)7 .

biophysical barrier that protects the underlying airway tissue
against inhaled pathogens, particulates, or chemical gases. It
protects the airway tissue via multiple mechanisms, including
intercellular tight junction formation, mucociliary clearance,
and antimicrobial and antioxidant secretion3 , 4 . The defective
Copyright © 2022 JoVE Journal of Visualized Experiments

Advances in lung-on-chip (LOC) technology represent an
opportunity to study human lung development, model various
lung diseases, and develop new therapeutic materials in
tightly regulated in vitro environments. For example, airway
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epithelium and endothelium can be cultured on opposite sides

that the trachea and newly implanted cells can be cultured

of a thin, porous membrane to mimic the gas exchanging lung

in the bioreactor without noticeable cell death and tissue

tissue, allowing faithful disease modeling and drug testing8 .

degradation for 4 days. We envision that the imaging-enabled

Similarly, in vitro disease models have been created to model

bioreactor platform, the thin film-based de-epithelialization

airway diseases in vitro, such as COPD9 and cystic fibrosis10 .

technique, and the cell delivery method used in this study can

However, a major challenge of LOC devices is recapitulating

be useful for generating airway tissues for in vitro disease

the complex three-dimensional (3D) architecture of the lung

modeling and drug screening.

tissue and dynamic cell-tissue matrix interactions in vitro11 .

The bioreactor includes a rectangular chamber connected

Recently, innovative tissue engineering methodologies have

to a programmable syringe pump, perfusion pump, and

been developed that allow manipulation of ex vivo lung

ventilator for culturing isolated rat trachea. The bioreactor

tissues12 . Using these methodologies, denuded allogenic

features inlets and outlets connected to the trachea or the

or xenogeneic tissue grafts can be prepared by removing

tissue culture chamber to separately supply reagents (e.g.,

the endogenous cells from the lung tissue via chemical,

culture media) to the internal and external spaces of the

physical, and mechanical treatments13 . In addition, the

trachea (Figure 1). A custom-built imaging system can be

preserved native tissue extracellular matrix (ECM) in the

used to visualize the interior of the in vitro-cultured rat

decellularized lung scaffolds provide the physio-mimetic

trachea at the cellular level (Figure 2). The endogenous

structural, biochemical, and biomechanical cues for implanted

epithelium of the trachea is removed via the instillation

cells to attach, proliferate, and differentiate14 , 15 .

of a detergent-based decellularization solution followed

Here, an imaging-guided bioreactor system created by
combining LOC and tissue engineering technologies to
allow in vitro tissue manipulation and culture of explanted
rat tracheal tissues is reported. Using this airway tissue
bioreactor, the protocol demonstrates selective removal
of the endogenous epithelial cells without disrupting the
underlying subepithelial cellular and biochemical components
of the airway tissue. We next show the homogenous
distribution and instantaneous deposition of the newly seeded
exogenous cells, such as mesenchymal stem cells (MSCs),
on the denuded airway lumen by instilling the cell-loaded
collagen I pre-gel solution. In addition, by using the microoptical imaging device integrated into the bioreactor, the

by vibration-assisted airway washing (Figure 3). Hydrogel
solution, such as type I collagen, is used as a delivery vehicle
for seeding exogenous cells uniformly and instantaneously
across the denuded trachea lumen (Figure 4). All the
materials used to construct the bioreactor and conduct the
experiments are provided in the Table of Materials.

Protocol
The animal tissue protocol below has been approved by the
animal welfare guideline and regulations of the Institute for
Animal Care and Use Committee (IACUC) at Stevens Institute
of Technology, and it complies with the National Institutes of
Health (NIH) guidelines for the use of experimental animals.

visualization of the trachea lumen during epithelium removal
and endogenous cell delivery is also done. Further, it is shown

Copyright © 2022 JoVE Journal of Visualized Experiments
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2.

1. Design and construction of imaging-guided rat
trachea bioreactor

Use software, such as Micro-Manager, to operate
the camera and acquire photos and videos. Aim
an object located at a long distance (e.g., 10 m

1.

Designing and fabrication of rat trachea bioreactor
1.

from the camera) and adjust the distance between

Create a computer-aided design (CAD) model of

the tube lens and imaging sensor of the camera

the bioreactor chamber with relevant design, such

until a focused image of the object is formed on

as inlets, outlets, and tissue culture chamber, using

the computer screen by the imaging software being

CAD generator software. For this study, use the

used.

geometry and dimensions presented in Figure 1A-

3.

C. The tutorial of CAD generator software can be
found
2.

dichroic mirror and a laser to the device using optical

in16 , 17 .

cage system components, including assembly rod,
threaded cage plate, and cage cube.

Export the generated CAD model to a computer
numerical control (CNC) controller software and cut

4.

Mount a GRIN lens (diameter = 500 µm) at the distal

CNC machine to create the bioreactor chamber. The

end of the lens tube via the XY translator. Adjust the

tutorial of the CNC controller software can be found

distance between the GRIN lens and the objective

in18 .

lens to form focused microscopic images (Figure

NOTE: In addition to PTFE, other plastic materials,

2A,B).

(UHMWPE) and polyetherimide can be used to
fabricate the culture chamber.

2. Isolation of the rat trachea
1.

Sanitize the surgical area and sterilize the surgical

Sterilize all bioreactor components, such as Luer

instruments using an autoclave at 121 °C for 30 min prior

adapters and screws, to avoid contamination of the

to the surgery.

tissues and cells cultured in the device. Assemble

2.

all bioreactor components to the main tissue culture

Place a rat in the induction chamber and deliver 2.5%
of isoflurane for 15 min using a small vaporizer to

chamber in a clean environment (Figure 1A).
2.

Connect the objective lens (20x) to the device.

the polytetrafluoroethylene (PTFE) plastic using a

such as ultra-high molecular weight polyethylene

3.

Mount a filter lens on a dual-edge super-resolution

anesthetize the animal. Assess the anesthesia depth by

Construction of gradient index (GRIN) lens-based

pedal reflex. To do this, firmly pinch the toe and confirm

imaging device

that the animal does not respond to the toe pinch.

1.

To create the in situ imaging device, insert a tube

3.

After anesthesia, remove the isoflurane from the

lens into a stackable lens tube and secure it using a

chamber and administer 1 mL of 1,000 unit/mL heparin

retaining ring. Mount the lens-tube assembly onto a

through the lateral tail vein to prevent blood clotting in the

scientific CMOS camera via a C-mount adapter.

pulmonary vasculature.

Copyright © 2022 JoVE Journal of Visualized Experiments
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4.

5.

To euthanize the animal, expose the animal to 5%

10. Tightly close the bioreactor lid with the acrylic plastic

isoflurane for an additional 15-20 min. Remove the

lid and screws. Close the bioreactor chamber tubing

animal from the induction chamber and place it on the

connections with the male/female Luer plugs to prevent

surgical board in a face-up supine position.

the flow of the culture medium in the tubing.

Fix the rat on the surgical board by immobilizing the legs
and tail using adhesive tape. Next, sterilize the rat's neck

3. Imaging-guided removal of the trachea
epithelium

and chest regions using 70% isopropyl alcohol (IPA).
Open the abdominal cavity by making a 3-4 cm incision

1.

fluorescent, place the bioreactor on the imaging stage

using scissors in the skin.

(Figure 3A).

NOTE: Be careful not to cut the skin deeply by pointing
2.

the tips of the scissors upward.
6.

kit by diluting the CFSE solution with 1x PBS.
NOTE: The concentration of the original CFSE solution

Perform the tracheotomy by making an incision using

is 10 mM (in dimethyl sulfoxide (DMSO)).

scissors in the midline of the neck and exposing the
trachea. Perform midline thoracotomy by making an

3.

trachea cannula at a flow rate of 5 mL/min. Stop the pump

reach the trachea end connected to the lung. Next, use

when the CFSE solution fills the trachea. Wait for 10 min,

a bicep and scissors to cut both ends of the trachea and

and then wash the trachea lumen by infusion of 10 mL of

isolate the trachea.

1x PBS using the syringe pump to remove the residual

After isolation, rinse the trachea using 20 mL of

unincorporated CFSE reagent.

1x phosphate-buffered saline (1x PBS). Transfer the
trachea to the bioreactor using sterilized biceps. Secure

4.

Insert the distal imaging end of the GRIN lens into the
trachea via the Luer connector attached to one end of

the two ends of the trachea to the Luer connector using

the trachea. Then, gently move the GRIN lens inside

a 4-0 suture thread.
9.

Infuse 500 µL of the CFSE solution through the trachea
via the syringe pump through the tubing connected to the

incision in the chest wall and cutting between the ribs to

8.

Prepare carboxyfluorescein succinimidyl ester (CFSE)
solution (concentration: 100 μM) in the CFSE cell labeling

Transect the inferior vena cava (IVC) using the scissors
and confirm the euthanasia by exsanguination.

7.

To visualize the trachea lumen either in bright-field or

the trachea until the trachea surface is focused and take

Deliver 5 mL of culture medium to the bioreactor chamber

photos and videos in bright-field or fluorescence at 20x

using the programmable syringe pump through the tubing

magnification.

connected to the bioreactor chamber at a flow rate of 5
5.

mL/min.
NOTE: The culture medium is composed of Dulbecco's
modified Eagle's medium (DMEM), recombinant human

For capturing bright-field images in the Micro-Manager
software follow the steps below.
1.

Introduce white light through the cage cube to

FGF-basic (0.1 ng/mL), fetal bovine serum (FBS, 10%),

illuminate the trachea lumen. Click on the Live icon

and antibiotic-antimycotic (1%).

to show the luminal surface of the trachea in real-

Copyright © 2022 JoVE Journal of Visualized Experiments
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time. Use Imaging Setting > Exposure (ms) to

trachea for 10 min at 37 °C. Instill another 50 µL of

change exposure time to the desired value. In this

SDS solution through the trachea and incubate for

study, the exposure time used was in the range of

10 min.

10 ms and 50 ms.
2.

3.

6.

3.

To adjust the contrast and brightness of images,

trachea lumen with 500 µL of 1x PBS via syringe

use the Histogram and Intensity Scaling window

pump at a flow rate of 10 mL/min for 3x. Place

to move black and white arrows at the endpoint of

the bioreactor on a shaker and mechanically vibrate

the interactive histogram display. Alternatively, use

the bioreactor at 20 Hz frequency and displacement

the Auto Stretch option that allows the software to

amplitude of approximately 0.3 mm to physically

adjust the brightness and contrast automatically to

promote detachment of SDS-treated epithelial cells

optimal levels.

from the trachea lumen.

Click on the Snap icon to freeze the image. Then,

NOTE: In this study, the shaker was custom-built

use Setting > Export Images as Displaced to save

by assembling a subwoofer speaker, a subwoofer

the images in the desired format. Alternatively, use

plate amplifier, and an accelerometer. A sinusoidal

Setting > ImageJ to directly export the image to the

waveform was generated by a computer and fed

ImageJ software and save it.

into the shaker via the amplifier, while the response
of the shaker was monitored via the accelerometer

To obtain photos and videos in fluorescent mode,

(Figure 3B). In addition, conventional shakers, such

illuminate the trachea lumen with CFSE-specific laser

as electromagnetic and inertia shakers, can be used

light (CFSE: excitation wavelength: 488 nm, emission

to promote the detachment of the cells. To do this,

wavelength: 515 nm) through the cage cube. Follow

set the frequency and acceleration of the shaker to

the steps 3.5.2-3.5.3 to acquire the images. After taking

20 Hz and 0.5 g, respectively (equivalent to 0.3 mm

photos and videos, gently remove the GRIN lens from the

displacement amplitude).

trachea.
7.

4.

Perform de-epithelialization as described below.
1.

Remove lysed epithelium and SDS by irrigating the

Prepare

2%

sodium

dodecyl

sulfate

Instill 500 µL of 1x PBS twice through the trachea
lumen to remove residual SDS and cell debris

(SDS)

while the trachea is mechanically vibrated. Following

decellularization solution in distilled (DI) water. Instill

the epithelium removal procedure, evaluate the

50 µL of SDS through the trachea at a flow rate

clearance of the epithelial layer by measuring the

of 6.3 mL/min, by using the syringe pump through

intensity of CFSE using the GRIN lens imaging

the trachea cannula to generate a thin film of the

device as in step 3.6 (Figure 3C).

detergent solution on the trachea lumen.
2.

Close the bioreactor's tubing connections using
male/female Luer plugs and transfer the bioreactor

4. Trachea tissue preparation for further analyses
1.

to an incubator. Allow the SDS to dwell within the

Copyright © 2022 JoVE Journal of Visualized Experiments
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trichrome, pentachrome, and immunostaining. To do this,

2.

1.

remove the trachea from the bioreactor, and fix it in 30

of 1x PBS. Cut the trachea tissue longitudinally

mL of 4% neutral buffered paraformaldehyde solution in

into small semi-cylinder sections (length: ~5 mm)

1x PBS (pH = 7.4) at 4 °C overnight.

using scissors and insert the tissue sections in the

Dehydrate and embed the fixed trachea tissue by

cassettes.

following the steps below.
1.

2.

2.

- 35%, 50%, 70%, 85%, 95%, and 100% - for 10

of 1x PBS, transfer the trachea to 30 mL of 70%

min in 30 mL of each solution. Remove the previous

alcohol, and keep it at 4 °C overnight. Cut the

solution before adding the next solution.
3.

hexamethyldisilazane

(HMDS)-based

drying method by submerging the tissues in the

tissue embedding cassettes (length x width x height:

following solutions: 100% IPA: HMDS (2:1; v/v) for

4 cm x 2.5 cm x 0.5 cm). Keep two trachea sections

10 min, followed by 100% IPA: HMDS (1:2; v/v) for

in each cassette.

10 min, and finally 100% HMDS for overnight.

Dehydrate the sections in a series of isopropyl

NOTE: HMDS is toxic. Work under a fume hood

alcohol (IPA) solutions - 85%, 90%, 95%, 100% - for

during all drying steps.
4.

Remove the tissues from the HMDS solution and

solution before adding the next solution.

allow them to dry under the fume hood for 1 h. Mount

Upon completion, submerge the cassettes in 30 mL

the section on aluminum pin stubs using a carbon

of clearing agent (e.g., xylene) for 2 h to displace

double-sided conductive tape or silver conductive

the IPA solution from the tissue sections completely.

paste for SEM imaging.

Perform this step in a fume hood with proper
ventilation.
4.

Perform

a sharp blade and insert the tissue sections in the

1 h in 30 mL of each solution. Remove the previous

3.

Dehydrate the sections in a series of IPA solutions

After fixation, wash the trachea tissue with 10 mL

trachea into small cylindrical sections (~5 mm) using

5. Homogeneous distribution of exogenous cells
onto the denuded tracheal lumen

Submerge the cassettes in paraffin for 2 h, and then
embed them in paraffin at 4 °C overnight. Next,

1.

cut the paraffin-embedded tissues into thin sections
(5-8 μm) using a microtome device for the H&E,

To prepare the tissues for scanning electron microscopy
(SEM) analysis, fix the trachea in 30 mL of 2.5%
glutaraldehyde solution in 1x PBS (pH = 7.4) at 4 °C
overnight. Then, dehydrate the fixed trachea tissue for
SEM by following the steps below.

Copyright © 2022 JoVE Journal of Visualized Experiments

Prepare a de-epithelialized rat trachea using the protocol
in step 3. Thaw frozen mesenchymal stem cells (MSCs)
for 30 s in a 37 °C water bath.
NOTE: In this study, we used mesenchymal stem

trichrome, pentachrome, and immunostaining.
3.

After fixation, rinse the trachea tissue with 10 mL
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induced-human pluripotent cells (iPSCs) can be used for
epithelium regeneration purposes.
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2.

Count the cells with a hemocytometer and prepare a

culture incubator at 37 °C and 5% CO2 for gelation. For

Label the cells fluorescently by incubating the cells with

collagen I, the gelation occurs in 30 min.
8.

the GRIN lens by wiping with 70% IPA or ethanol and

1x PBS for 3x and resuspend the cells in fresh culture

place the bioreactor on the imaging stage. Take photos

107

cells/mL.

and videos in both bright-field and fluorescent modes as
needed.

Prepare hydrogel pre-gel solution as a vehicle for cell
delivery. For this study, use collagen I as a delivery

9.

medium into the trachea lumen using a syringe pump at

instructions to prepare the pre-gel. For example, to obtain

a flow rate of 1 mL/min.
10. Culture the cell-seeded trachea within the bioreactor in

neutralization solution with nine parts of the rat tail

an incubator at 37 °C for the desired time. For long-

collagen in a 1.5 mL sterile tube. Then, gently pipet the

term culture, refresh the culture medium in the trachea

mixture up and down for adequate mixing.

lumen and the bioreactor chamber every 24 h. During the

NOTE: Other biocompatible hydrogels may be used

cell culture, keep the media inside the lumen static and

instead of collagen I according to the study and user

change it every 24 h, while the media outside the trachea

needs.

is continuously perfused via a unidirectional flow at 5 mL/

Once the hydrogel solution is prepared, add the cells
quickly to the solution with desired concentration (e.g.,
5 x

106

min.
11. After culturing the cells for a certain time period (e.g., 1

cells/mL). To obtain a uniform cell-hydrogel

and 4 days in this study), remove the trachea from the

mixture, mix the cells and gel solution by gently pipetting

bioreactor. Use scissors to cut the trachea longitudinally

with a micropipette.

into two semi-cylinder sections (i.e., upper and lower

Attach one end of the trachea within the bioreactor to a

sections) on days 1 and 4 of in vitro culture to expose the

programmable syringe pump through a Luer connector.

inner surfaces for monitoring cell growth and calculating

Deliver 5 mL of fresh culture medium at 37 °C into the

cell density. Use a conventional fluorescent microscope

bioreactor chamber to cover the exterior surface of the

to visualize the cells on the inner surfaces.

trachea using the syringe pump at a flow rate of 5 mL/

6.

After 30 min of cell seeding, infuse 1 mL of culture

vehicle for MSCs cells and follow the manufacturer's

3.6 mg/mL collagen pre-gel, mix one part of the chilled

5.

To visualize the distribution of implanted cells, sterilize

temperature for 15 min. Rinse the cells with 5 mL of

medium at a final concentration of 3 x

4.

After cell injection, place the bioreactor in a sterile cell

cell solution with a concentration of 5 x 106 cells/mL.

2 mL of CFSE solution (concentration: 100 µM) at room

3.

7.

12. To acquire the images using Micro-Manager software,

min.

follow steps 3.5 and 3.6. Use a fluorescein isothiocyanate

Administer a 10 µL bolus of the cell-hydrogel mixture into

(FITC) filter to visualize the CFSE-labeled cells in

the de-epithelialized trachea within the bioreactor using

fluorescence mode. Analyze the images taken by the

the syringe pump at a flow rate of 5 mL/min to generate

fluorescent microscope and calculate cell densities on

a cell-hydrogel layer on the trachea lumen (Figure 4).

upper and lower sections using the ImageJ software. To

Copyright © 2022 JoVE Journal of Visualized Experiments
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calculate the number of cells and the cell density, follow

was observed throughout the epithelium (Figure 5Ci).

the steps below.

Following de-epithelialization via SDS and vibration-assisted

1.

Open an image in ImageJ software and convert the

airway irrigation, the intensity of the fluorescent signal was

image to a binary image (16-bit) using Image > Type

decreased significantly (Figure 5Cii), indicating ablation of

> 16-bit. Set the image scale with the scale bar using

the epithelium.

2.

Analyze > Set Scale.

The H&E images of de-epithelialized trachea showed

Adjust the threshold of the image to highlight the

the removal of the pseudostratified epithelium from the

structures of the cells to count. Use Image > Adjust

trachea lumen and preservation of the cells and ECM

> Threshold. Use Analyze > Analyze Particles to

microstructure in underlying tissue layers (Figure 6A).

count the number of the cells. Calculate the density

Moreover, pentachrome (Figure 6B) and trichrome staining

of the cells by dividing the number of cells by the

(Figure 6C) confirmed the maintenance of the trachea tissue

surface area of the image.

architecture and the ECM components, such as collagen

13. To assess the viability after cell seeding, use a cell

and proteoglycans. Furthermore, immunofluorescence of

viability kit. For this study, incubate the trachea tissue

epithelial cells (epithelial cell adhesion molecule, EpCAM;

and the cells in the bioreactor at 37 °C for 6 h and

Figure 6D) and collagen I (Figure 6E) revealed complete

stain the cells with 4 mM calcein-AM and 2 mM ethidium

removal of the epithelium and preservation of collagen I

homodimer-1 in 1 mL of 1x PBS at room temperature for

within the subepithelial tissue. SEM imaging of native trachea

15 min.

showed that the luminal surface of native rat trachea mainly

14. After rinsing with 1x PBS, visualize the cells using a
fluorescent microscope. Count the live and dead cells
using the steps described in step 5.12. Calculate cell
viability as the percentage of live cells (stained with
calcein-AM) per total cells (both live and dead cells).

was populated with multi-ciliated cells and goblet cells. On
the other hand, SEM images of de-epithelialized trachea
lumen showed that the basement membrane was exposed as
indicated by a mesh network of ECM fibers and the absence
of epithelial cells (Figure 6F).
Using de-epithelialized rat tracheas and fluorescently labeled

Representative Results

cells, we investigated whether incorporating a hydrogel as

The GRIN lens-based in situ imaging modality can allow

a cell delivery vehicle could achieve homogeneous cell

visualization of the tracheal inner lumen in situ (Figure 5A).

distribution onto the de-epithelialized tracheal lumen (Figure

Using this imaging method, both bright-field and fluorescent

7A,B). In this study, the mesenchymal stem cells (MSCs)

images of the native and de-epithelialized tracheas can

were used as the model cells for the cell delivery and culture

be obtained (Figure 5B,C). No fluorescent signal was

study. As described in the protocol (step 5), we instilled MSC-

observed from the native trachea prior to CFSE labeling

loaded collagen I pre-gel into a de-epithelialized rat trachea

(Figure 5Bii). However, when the tracheal epithelium was

and monitored the distribution of the cells on the tracheal

labeled with CFSE dye, a uniform fluorescent signal (green)

lumen using the GRIN lens imaging system. As a control

Copyright © 2022 JoVE Journal of Visualized Experiments

jove.com

April 2022 • 182 • e63544 • Page 8 of 20

experiment, we suspended MSCs in the culture medium,

Furthermore, we cultured the cell-seeded tracheas for 4 days.

infused the cell-loaded culture medium into the trachea, and

The cells seeded via both collagen and culture medium

visually inspected the distribution of the cells. In situ imaging

(control) proliferated on the de-epithelialized trachea lumen

results showed that the fluorescently labeled cells delivered

surface as indicated by the increased number of cells

via hydrogel remained adhered more uniformly across the

expressing CFSE over time in both the upper and lower

lumen than those seeded via culture medium (Figure 7B).

half of the tracheal lumen (Figure 7D). Notably, in the

We then tested the cell viability before and after cell delivery

collagen hydrogel delivery group, the difference in the density

to evaluate potential cell damage and death due to shearing

of the cells between upper and lower lumens was smaller

stress during cell infusion. The result showed that cell viability

than that in the control group, indicating cell delivery via

was not significantly affected by the cell delivery procedure

hydrogel promotes homogeneous cell distribution throughout

as over 90% of cells remained viable (Figure 7C).

the trachea lumen.

Copyright © 2022 JoVE Journal of Visualized Experiments
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Figure 1: Three-dimensional (3D) computer drawing of the trachea bioreactor. (A) (i) side view, (ii) top view. (B) The
dimensions of the bioreactor chamber. (C) A transparent acrylic plastic sheet is cut and attached to the top of the main
chamber using screws. Unit = mm; R = radius. Please click here to view a larger version of this figure.
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Figure 2: Custom-built micro-fiber imaging for in situ visualization of the rat trachea. (A) (i) Schematic of the imaging
setup components of the light path. Abbreviations: C = camera, TL = tube lens, F = filter, DM = dichroic mirror, OL =
objective lens; (ii) photograph of the imaging setup components showing the imaging probe (GRIN lens) is inserted in
the Luer connector of the bioreactor. (B) Schematic showing that the GRIN lens is integrated with the bioreactor. (C) A
photograph showing the imaging probe is used to visualize the trachea inside the bioreactor. Please click here to view a
larger version of this figure.
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Figure 3: The platform for de-epithelialization of rat trachea. (A) Photograph showing the experimental setup for deepithelialization and in situ optical fiber imaging. (B) Diagram showing the component and assembly of the custom-built
electromagnetic shaker used to facilitate epithelium removal. ω: frequency, a: amplitude (C) Schematic showing the workflow
of rat trachea de-epithelialization procedure. PBS = phosphate-buffered saline. Please click here to view a larger version of
this figure.

Figure 4: Delivery of exogenous cells into de-epithelialized rat trachea using hydrogel. Schematic showing hydrogel
solution used as a delivery vehicle to topically deposit the cells onto the inner lumen of the de-epithelized rat trachea. Please
click here to view a larger version of this figure.

Copyright © 2022 JoVE Journal of Visualized Experiments
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Figure 5: In situ imaging of de-epithelialized trachea. (A) Photograph showing fluorescent imaging of the trachea
lumen while the CFSE-labeled epithelium is excited with 488 nm blue laser through GRIN lens. (B) (i) Bright-field and (ii)
fluorescence images of the trachea lumen before epithelium labeling. (C) Fluorescence images of the (i) native and (ii) deepithelialized trachea (De-Epi trachea) while the epithelium is labeled with CFSE fluorescent dye. Please click here to view a
larger version of this figure.
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Figure 6: Histology, immunofluorescence, and SEM analyses of native and de-epithelialized rat tracheas. (A) H&E
staining. (B) Pentachrome staining where purple is cell cytoplasm, blue is cell nuclei, green is proteoglycans (e.g., mucin),
and yellow is collagen fibers. (C) Trichrome staining where pink is cell cytoplasm, dark blue is cell nuclei, and blue is
collagen. Fluorescence images of native and de-epithelialized tracheas. (D) EpCAM and (E) collagen I. Arrowheads show
the surface of the trachea lumen. (F) SEM micrographs of the trachea lumen. Please click here to view a larger version of
this figure.
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Figure 7: Topical deposition of the exogenous MSCs in the trachea lumen. (A) (i) Bright field and (ii) fluorescence
images of the de-epithelialized trachea. (B) Fluorescent images of the de-epithelialized trachea lumen when it is seeded
with (i) PBS and (ii) collagen I pre-gel. The homogenous distribution of the cells onto the trachea lumen is achieved when
pre-gel collagen is used as a delivery vehicle for cells. (C) (i) Fluorescent images and (ii) quantified viability of the cells
before and after 6 h of delivery by pre-gel collagen. n: number of samples. Steps 5.1 and 5.17 of the protocol were followed
to assess the viability of the cells. (D) Cell seeding density measured after (i) 1 day and (ii) 4 days after cell seeding and
culture. The cell density was calculated by dividing cell numbers by the examined surface area. All values represent mean
± standard deviation. One-way analysis of variance (ANOVA) was used to determine statistically significant differences
between groups, with p < 0.05 considered significant. Abbreviations: CM = culture medium, C = collagen. *p < 0.05. **p <
0.01. ns: not significant. No significant difference (ns) between upper and lower surfaces means uniform cell distribution
across the circumference of the trachea. Please click here to view a larger version of this figure.
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Discussion

method described in this study uses a small amount of

In this work, we created an imaging-guided bioreactor that
can allow (i) monitoring of the trachea lumen in situ after
the cell removal and exogenous cell delivery and (ii) longterm in vitro culture of the cell-seeded trachea tissue. Using
this custom-built bioreactor, we demonstrated (i) selective
removal of the endogenous epithelial cells from the trachea
lumen using detergent and vibration-assisted airway wash
and (ii) uniform distribution of exogenous cells onto the
luminal surface of the denuded trachea using cell-loaded
collagen I pre-gel. Moreover, the GRIN lens-based imaging
modality confirmed the removal of the epithelium in situ.

detergent (less than 50 μL) for the epithelium ablation while
allowing preservation of the underlying tissue layer and
subepithelial cellular components. Mechanical vibration of the
detergent-exposed tissue demonstrated in this study is an
important procedure as it permits detachment and clearance
of the lysed cells. The cell debris and partially disrupted cells
resulting from exposure of the epithelium to the detergent are
challenging to be washed only by flooding the trachea with
the washing solution. Therefore, mechanically vibrating the
trachea during washing provides sufficient shear forces to
clear the cell debris from the tracheal lumen.

Furthermore, with further analyses, including H&E, trichrome,

In general, the pre-gel-based cell seeding approach can

pentachrome, immunofluorescence staining, and SEM, we

be influenced by delivery speed, the viscosity of the pre-

confirmed the removal of the epithelium and maintenance

gel (that is directly related to the pre-gel concentration),

of the architecture and components of underlying tissue

surface tension, and gelation time. In particular, during

layers. In addition, the GRIN lens-based imaging of newly

pre-gel preparation, it is essential to maintain the pre-gel

implanted exogenous MSCs showed the uniform distribution

concentration low enough to transport the cell-suspended

of the cells when collagen I pre-gel was used as a delivery

pre-gel in the tubing and high enough to maintain the cells

vehicle. Lastly, the implanted cells survived and proliferated

on the upper surface of the trachea. Therefore, it is strongly

on the de-epithelialized trachea, highlighting the efficacy of

recommended to find the optimum concentration for each pre-

the bioreactor in the long-term culture of the cell-seeded

gel by testing various concentrations. In addition, practice

airway tissues.

the delivery technique such as the delivery speed with less

The critical step in the de-epithelialization protocol is creating
a thin detergent solution layer in the trachea lumen.
In current decellularization protocols, multiple cycles of
chemicals and enzymes are being used over a long period,
reducing the number of collagen fibers, glycosaminoglycans
(GAGs), proteoglycans, and chondrocytes, compromising
the biological and biomechanical properties of the airway
scaffold19 , 20 , 21 . On the other hand, the ECM provides
biochemical and mechanical cues and suitable physical
environments for survival, proliferation, and differentiation
of implanted exogenous cells22 , 23 . The thin-film deposition
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precious cells to ensure the successful delivery of the cellloaded pre-gel. Moreover, while we used MSCs as a cell
model to demonstrate (i) the distribution of the cells with
pre-gel as a delivery vehicle and (ii) the capability of the
bioreactor system for culturing the newly seeded cells on
denuded trachea lumen, the use of stem cells (e.g., basal
cells) and primary airway epithelial cells in future studies could
allow studying cell differentiation and functional epithelial
cell regeneration24 , 25 . In addition, future studies can include
adding an air-liquid interface (ALI) to the current platform to
generate in vivo-like shear stress on seeded cells for the
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generation of functional epithelium. To add ALI to the current

where the surface tension is dominant. Forming a liquid

device, a small animal ventilator can be connected to the

plug and creating a thin film of the de-epithelialization

trachea inlet to ventilate the trachea. Moreover, to achieve the

solution or cell-loaded pre-gel suspension in larger airways,

ALI, the thin-film deposition method can be utilized to instill a

such as swine and human trachea, or bronchi, can be

culture medium liquid plug into the cell-seeded trachea. The

challenging as the surface tension becomes negligible

thickness of the liquid film can be modulated by changing the

compared with other forces, gravity in particular. Moreover,

liquid plug velocity26 , 27 . The plug can be initiated after the

by using the thin-film deposition approach and modulating

newly seeded cells adhere and engraft firmly onto the trachea

time and concentration, we were able to ablate the

lumen.

epithelium with a strong detergent (SDS) and preserve the

In addition, in situ GRIN lens-based imaging approach used
in this protocol is critical for confirming the efficacy of the
de-epithelialization and assessing the quality of distribution
of newly seeded cells. Unlike conventional tissue analyses
methods, such as histology and immunofluorescence, which
require dissecting the samples from the trachea tissue for
analysis, the imaging platform developed in our study allows
rapid and non-destructive monitoring of the airway lumen
during de-epithelialization and cell delivery. To keep the
trachea sterilized during in situ imaging, make sure to sterilize
the GRIN lens by wiping it with 70% IPA or ethanol before
introducing it into the trachea lumen. Moreover, to image
the cells using the GRIN lens, the cells (either endogenous
tracheal epithelial cells or newly implanted cells) can be

underlying tissue layer. In future studies, however, milder
decellularization detergents, such as 3-[(3-cholamidopropyl)dimethylammonio]-1-propanesulfonate (CHAPS)28 , or nondetergent solution, such as sodium hydroxide (NaOH)29 ,
can be tested for the preservation of ECM components
and support of newly implanted cells. Furthermore, the
fluorescence intensity of CFSE-labeled cells reduces over
time due to the division of the cells. In our study, the
fluorescent images of MSCs cultured on the de-epithelialized
tracheas for 4 days showed a substantial decrease in their
fluorescence intensity. For prolonged monitoring and tracking
of exogenous cells seeded onto the tissue scaffolds, different
cell labeling methods that can allow long-term or permanent
fluorescent labeling of the cells would be necessary.

labeled with various fluorescent dyes with different excitation/

We envision that the imaging-guided bioreactor platform

emission wavelengths. To do this, make sure to use the

and cell removal and delivery protocols described in this

appropriate laser light generator to excite the fluorescently

report can allow the creation of de-epithelialized airway tissue

labeled cells and integrate the right filter lenses to the dual-

scaffolds that can be used to generate the bioengineered

edge super-resolution dichroic mirror.

airway tissues. Such in vitro airways can offer high-fidelity in

Despite the novelty and innovativeness of the deepithelialization, cell delivery, and in situ imaging methods,
this study has several limitations. The de-epithelialization
and cell delivery methods described in this study are
applicable to small airways (diameter: less than 3-4 mm)
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vitro modeling of human airway diseases and drug screening.
For example, to establish functional airway epithelium,
airway basal stem cells can be first implanted onto the deepithelialized airway tissue30 . Then, the air-liquid interface
(ALI), which is critical for the differentiation of basal stem
cells into various epithelial cells, can be generated within the
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trachea. Moreover, the in situ imaging system can be modified

3.

Gohy, S., Hupin, C., Ladjemi, M. Z., Hox, V., Pilette,

and used to fluorescently visualize the respiratory tract of

C. Key role of the epithelium in chronic upper airways

patients with lung airway disorders. To be used clinically to

diseases. Clinical and Experimental Allergy. 50 (2),

evaluate airway tissues in situ, the rigid GRIN lens can be

135-146 (2020).

replaced with flexible optical fiber imaging probes to navigate
the airways. Furthermore, the ability to homogeneously

4.

function of airway tract epithelium. Tissue Barriers. 1 (4),

distribute the cells inside the respiratory tract using hydrogel-

e24997 (2013).

based cell seeding can provide an unprecedented opportunity
to replace damaged or injured epithelium in patients. In

Ganesan, S., Comstock, A. T., Sajjan, U. S. Barrier

5.

De Rose, V., Molloy, K., Gohy, S., Pilette, C., Greene,

particular, the cell replacement approach developed and

C. M. Airway epithelium dysfunction in cystic fibrosis

used in this study can accelerate cell-based treatment for

and COPD. Mediators of Inflammation. 2018, 1309746

treating respiratory disorders, such as cystic fibrosis and

(2018).

primary ciliary dyskinesia, and repairing donor lungs that are

6.

Horani, A., Ferkol, T. W. Advances in the genetics of

refused for transplantation due to severely injured airway

primary ciliary dyskinesia: Clinical implications. Chest.

tissues31 , 32 , 33 , 34 .

154 (3), 645-652 (2018).
7.
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